
Experiment NP-1: Reflex Response to Auditory and Visual Stimuli

Background

During our day-to-day lives we detect changes in the environment and react appropriately. An external 
stimulus is detected by one or more neurons, which sends the sensory information to the central 
nervous system, where it is processed. If a motor response is initiated, it usually involves a series of 
action potentials which produce a muscle contraction and a movement of one or more parts of the body.
A simple reflex is perhaps the easiest of this type of stimulus-response reaction. A loud sound or 
something flying at your eye makes you blink, while a tap on the tendon under the knee cap produces 
the knee-jerk (or myotactic) reflex.

Figure NP-1-B1: A cross section of the spinal cord showing the single synapse between the sensory 
and the motor neurons involved in the myotactic reflex.

A simple reflex like the myotactic reflex is produced via single synapses between sensory axons and 
motor neurons. The required circuitry for this reflex is confined to the spinal cord, as shown in Figure 
NP-1-B1. Sensory information also ascends to higher centers, but the brain is not necessary or required 
to perform the reflex. More complex reflexes usually involve additional (inter-) neurons and more than 
one population of motor neurons. Thus, more neurons and synapses are involved, which usually results 
in a longer delay between stimulus and response and often a more complex response. One example of 
such a complex response is the flexion withdrawal reflex, where a noxious stimulus to one leg causes 
withdrawal of the stimulated leg and extension of the other.

In this lab you will study the time taken between a stimulus and the response. These reaction time 
measurements will be made from an individual subjected to harmless visual and sound stimuli. In 
addition, the effect of priming and prediction will be examined.
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Equipment Required

PC or Mac Computer

IX-ELVIS

USB cable

Power supply

EMN-100 Event marker

IX-ELVIS Setup

1. Place the IX-ELVIS unit on the bench, close to the computer. 

2. Connect the IX-ELVIS to the computer with the supplied USB cable. 

3. Insert the power plug into the rear of the IX-ELVIS and plug the transformer into the electrical 
outlet. Turn on the power switches on the rear and on the upper right side of the top of the unit 
and confirm that the LEDs are illuminated.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 
not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, ELVISNI.iwxgrp. Select this group and click 
Open.

4. Pull down the Settings menu again. Select the ReflexResponse-LS2 settings file.

5. After a short time, LabScribe will appear on the computer screen as configured by the 
ReflexResponse-LS2 settings.

6. The settings used to configure the LabScribe software and the IX-ELVIS for this experiment are
programmed on the Preferences Dialog window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.
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Event Marker Setup

1. Locate the EMN-100 event marker (Figure NP-1-S1).

Figure NP-1-S1: The EMN-100 event marker.

2. Plug the mini-DIN connector to the EMN-100 event marker into the Channel 3 input of the IX-
ELVIS (Figure NP-1-S).

Figure NP-1-S2: The EMN-100 event marker connected to the IX-ELVIS.
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Exercise 1: Reaction Time and Visual Cues

Aim: To measure the reaction time of a subject to a visual cue.

Procedure

1. Instruct the subject to:

• Sit in a chair and face the computer screen.

• Position a hand on the keyboard in a manner that enables the subject to push the Enter key 
as quickly as possible.

• Watch the right side of the computer screen and quickly press the Enter key on the keyboard
when the signal generated by the event marker first appears.

2. Out of sight of the subject, another student should prepare to quietly press and release the 
button of the event marker. In this exercise, the subject will perform ten trials.

Warning: In this exercise, it is important to press and release the button of the event marker 
quietly because any sound could be used by the subject as a cue.

3. Type “<Subject’s Name> Visual Cues” in the Mark box that is to the right of the Mark button. 

4. Click on the Record button. Instruct the subject to press the Enter key on the keyboard to mark 
the recording as soon as he or she sees the visual cue on the right side of the computer screen 
(Figure NP-1-L1).

Figure NP-1-L1: Three visual cues, each followed by the subject’s response, are displayed on the Main 
window. Each visual cue is made by pushing the button of the EMN-100 event marker momentarily; 
each response mark is made by the subject pushing the Enter key on the keyboard.
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5. Instruct the subject that the exercise has begun and that a visual cue could appear on the screen 
at any time – remind them to click the Enter key as soon as they see the visual cue.

6. Click the event marker quietly to deliver ten visual cues to the subject. The cues should not be 
less than three seconds nor more than five seconds apart. 

7. After the tenth cue, click Stop to halt recording.

8. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file. Designate the file type as *.iwxdata. Click on the Save button to save 
the data file. 

Data Analysis

1. Scroll to the beginning of the data recorded for Exercise 1 to display the first trial on the Main 
window.

2. Use the Display Time icons to adjust the Display Time of the Main window to show both the 
visual cue made with the event marker and the mark made by the subject’s response on the 
Main window. This trial can also be selected by:

• Placing one cursor before the beginning of the visual cue and the second cursor after the 
mark made by the subject; and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the complete
reaction trial to the width of the Main window.

Figure NP-1-L2: The LabScribe toolbar.

3. Click on the Analysis window icon in the toolbar (Figure NP-1-L2) or select Analysis from the 
Windows menu to transfer the data displayed in the Main window to the Analysis window 
(Figure NP-1-L3).

4. Look at the Function Table that is above the display of the Reaction Time channel displayed in 
the Analysis window. The mathematical function, T2-T1, should appear in this table. The value 
for T2-T1 is seen in the table across the top margin of the Reaction Time channel.

5. Use the mouse to click on and drag a cursor to the onset of the signal used as the visual cue. 
Drag the other cursor over the mark made by the subject responding to the visual cue.

6. Once the cursors are placed in the correct positions for determining the reaction time, record the
value for T2-T1 in the Journal. The value can be recorded in the on-line notebook of LabScribe 
by typing its name and value directly into the Journal. You may also record any data on separate
data tables.
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7. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the name and value for T2-T1 into the Journal. To use these functions:

• Place the cursors at the locations used to measure the reaction time.

• Transfer the name of the T2-T1 function to the Journal using the Add Title to Journal 
function in the Reaction Time Channel pull-down menu.

• Transfer the value for T2-T1 to the Journal using the Add Ch. Data to Journal function in the
Reaction Time Channel pull-down menu.

8. Once the reaction time in the first trial is measured and recorded, use the scroll bar at the 
bottom of the Analysis window to move the data from the second trial onto the window. If 
needed, use the Display Time icons to adjust the width of the Analysis window to show both the
visual cue and the subject’s response on the same window.

9. Repeat Steps 5 through 7 on the data from the second trial.

10. Use the same techniques used in Steps 5 through 8 to measure the reaction times from the other 
eight trials.

11. Once the reaction times in all ten trials have been measured and recorded, open the Journal and 
use the values to determine the mean reaction time of the subject. Discard the longest and 
shortest times from the data set, and determine the average of the eight remaining reaction 
times. Record the mean reaction time for this exercise in Table NP-1-L1.

Figure NP-1-L3: A visual cue, followed by the subject’s response, are displayed on the Analysis 
window. The two cursors are positioned at the beginning of the visual cue and on the mark for 
measurement of the subject’s reaction time (T2-T1) in this trial.
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Exercise 2: Reaction Time and Auditory Cues

Aim: To measure the reaction time of a subject to an auditory cue.

Procedure

1. Cover the computer screen with an opaque piece of construction paper to prevent the subject 
from seeing any signal on the screen as a visual cue.

2. Instruct the subject to:

• Sit in a chair in front of the computer keyboard facing AWAY from the screen.

• Listen for the click (sound) of the Enter key as the other student presses it and to click the 
button of the Event Marker as quickly as possible to mark the recording.

Note: The subject is now holding the event marker, while the student operting the computer 
will be clicking the Enter key.

3. Out of sight of the subject, another student should prepare to sharply click the Enter key to 
create an auditory cue that is also recorded as a signal on the Reaction Time channel. In this 
exercise, the subject will perform ten trials.

4. Type “Auditory Cues” in the Mark box that is to the right of the Mark button. 

5. Click on the Record button. Instruct the subject to press the Event Merker to mark the recording
as soon as they here the Enter key click.

6. Instruct the subject that the exercise has begun and that an auditory cue could be heard at any 
time.

7. Use the Enter key to deliver ten auditory cues to the subject. The cues should not be less than 
three seconds nor more than five seconds apart. 

8. After the tenth cue, click Stop to halt recording.

9. Select Save in the File menu. 

Data Analysis

1. Use the same technique explained in Exercise 1 to measure and record the reaction times of the 
subject presented with auditory cues.

2. Enter the mean reaction time for this exercise in Table NP-1-L1.

Questions

1. How does the subject’s mean reaction time to visual cues compare to his or her mean reaction 
time to auditory cues?

2. What would cause a longer reaction time to one type of cue as compared to another?

3. How do your subject’s mean reaction times compare to those of other subjects?

4. Do all subjects respond more quickly to the same cue?
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Exercise 3: Reaction Time and Prompted Auditory Cues

Aim: To measure the reaction time of a subject to an auditory cue delivered immediately after a 
verbal prompt.

Procedure

Repeat Exercise 2 with an additional step. Before each auditory cue is delivered, tell the subject to get 
ready to respond to the cue. It is best to use a one word cue, such as: “now” or “go”, before 
immediately clicking the event marker button.

Data Analysis

1. Use the same technique explained in Exercise 1 to measure and record the reaction times of the 
subject presented with prompted auditory cues.

2. Enter the mean reaction time for this exercise in Table NP-1-L1.

Exercise 4: Reaction Time and Predictable Auditory Cues

Aim: To measure the reaction time of a subject to auditory cues delivered at a predictable 
interval.

Procedure

Repeat Exercise 2 with a predictable interval of three seconds between each auditory cue.

Data Analysis

1. Use the same technique explained in Exercise 1 to measure and record the reaction times of the 
subject presented with predictable auditory cues.

2. Enter the mean reaction time for this exercise in Table NP-1-L1.

Questions

1. To which auditory cue did your subject respond most quickly? The one with the verbal cue, the 
one with no cue or the one with the predictable time?

2. To which auditory cue from question 1 did your subject respond to most slowly? For what 
reasons?

3. Did your subject respond more quickly or more slowly to same auditory cue as the other 
members of the class?
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Table NP-1-1: Mean Reaction Times for Different Cues.

Cue
Mean Reaction 
Time of Your 
Subject (ms)

Mean Reaction 
Time of All 
Subjects (ms)

Shortest Mean 
Reaction Time in 
Class (ms)

Longest Mean 
Reaction Time in 
Class (ms)

Visual

Auditory

Prompted Aud.

Predictable
Aud.
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